7.1

LESSON 7

Producing a Slide
Show
After completing this lesson, you will be able to:
 Annotate slides during a slide show.
 Set slide transitions.
 Animate slide text.
 Animate slide objects.
 Hide a slide during a slide show.
In Microsoft PowerPoint, you can display presentations on your computer
monitor using Slide Show view. Slide Show uses your computer like a
projector to display a presentation on one or two monitors using the full screen
or, using special hardware, on an overhead screen. You can set up a slide show
to operate manually or continuously, unattended. To make your slide shows
more exciting and engaging, you can add animation to text and graphics on the
slide to display during a slide show. As you present a slide show, you can also
take notes to document discussion points that members of your audience
express during the presentation.
As vice president of sales at Contoso Ltd, you have been working on a
company presentation. You are ready to rehearse the slide show for Wendy
Beth Kahn, the CEO, who wants to see it before you give the presentation at
next month’s meeting of department heads.
In this lesson, you will learn how to draw on a slide during a slide show, add
slide transitions, animate text, animate objects, and hide a slide during a slide
show.
To complete the procedures in this lesson, you will need to use a file named 07
PPT Lesson in the Lesson07 folder in the Presentation Fundamentals Practice
folder that is located on your hard disk.
1

Start PowerPoint, if necessary.

2

On the Standard toolbar, click the Open button.

3

Navigate to the Lesson07 folder in the Presentation Fundamentals
Practice folder, and then open the 07 PPT Lesson file.

4

On the File menu, click Save As, type Contoso Company Pres 07
in the File name box, and then click Save.
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Annotating Slides During a Slide Show
During a slide show presentation, you can annotate slides by drawing freehand
lines and shapes to emphasize a point. To do this, you choose the pen tool from
the Show Popup menu and then begin drawing. You can change the pen color
at any time during the presentation by choosing a new color from the Show
Popup menu.
In this exercise, you use the pen tool to underline the slide title during a slide
show and to change the pen color.
1

Drag the scroll box to slide 8, and then click the Slide Show button.
PowerPoint displays the current slide in the presentation.

2

Right-click anywhere on the screen, point to Pointer Options, and
then click Pen.
The pointer changes to the pen tool. Now you are ready to draw on
the slide.

important
When the pen tool is active in Slide Show view, clicking the mouse does not
advance the slide show to the next slide. You need to change the pen tool
back to the pointer to advance using the mouse.
3

Draw a line under the bulleted point Creation.

4

Right-click anywhere on the screen, point to Screen, and then click
Erase Pen.
PowerPoint erases the annotation. You can also press E to erase
annotations.

5

Click the Show Popup menu button, point to Pointer Options, and
then point to Pen Color.
The Pen Color menu appears with a selection of different colors.

6

On the Pen Color submenu, click Cyan.

7

Draw a line under the bulleted item Production.

8

Right-click the mouse, point to Pointer Options, and then click
Automatic.
The pen tool changes back to the pointer, which allows you to click
the mouse to advance to the next slide.

9

Press Esc.
The slide show ends, and PowerPoint displays slide 8 in Normal
view.
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Setting Slide Transitions
Transition effects help your presentation make more of an impact by varying
the way one slide replaces another. A slide transition is the visual effect of a
slide as it moves on and off the screen during a slide show. Slide transitions
include such effects as Checkerboard Across, Cover Down, Cut, and Split
Vertical Out. You can set a transition for one slide or a group of slides by first
selecting the slides in Slide Sorter view or in the Slides tab in Normal view and
then applying the transition. You can also set the length of time between slides,
the direction of the transition, and when the transition takes place. The Slide
Transition task pane is the fastest and easiest way to apply a slide transition
effect, set the transition speed and transition sound, and determine settings for
advancing a slide.
In this exercise, you apply a slide transition effect to a single slide, apply a
transition to multiple slides, and then change the transition speed.
1

Click the Slide Sorter View button, and then select slide 1.

2

On the Slide Show menu, click Slide Transition.
The Slide Transition task pane appears with current slide transition
options.

3

Under Apply to selected slides, scroll down, and then click
Dissolve.
PowerPoint previews the transition effect on the slide miniature for
Slide 1 in Slide Sorter view and places a transition symbol below
the lower-left corner of the slide. The symbol indicates that
PowerPoint has applied a slide transition effect to this slide.

4

Click the transition symbol below slide 1.
PowerPoint demonstrates the Dissolve transition effect on slide 1.
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5

Click the Slide Show button.
Slide Show view displays slide 1 with the Dissolve transition effect.

6

Press Esc to end the slide show.

7

On the Edit menu, click Select All.
All of the slides in the presentation are selected. Deselect slide 1
because it already has a slide transition.

8

Hold down Ctrl, and then click slide 1 to deselect it.

9

In the Slide Transition task pane, under Apply to selected slides,
scroll down and then click Random Bars Horizontal.
The slide miniatures demonstrate the transition effect.

10

Under Modify transition, click the Speed down arrow, and then click
Medium.
PowerPoint applies the transition effect to the selected slides.
Notice that all of the slides have a transition symbol below their left
corners.

11

Click the Slide Show button.
Slide Show view displays slide 2 with the Random Bars Horizontal
effect.

12

Click the mouse several times to advance through the slides and
watch the transition effect, and then press Esc to end the slide
show.
PowerPoint returns you to Slide Sorter view.

13

Press Ctrl+A to select all the slides.

14

In the Slide Transition task pane, under Apply to selected slides,
scroll up and click No Transition, and then click a blank area of the
presentation window.
PowerPoint removes the transition effect for all of the slides.

15

In the Slide Transition task pane, click the Close button to close the
task pane.

Animating Slide Text
You can make a slide show more exciting and engaging by adding animation to
the text and graphics on your slides. During a slide show, slide text can appear
on the screen one paragraph, word, or letter at a time. A slide with text that you
set to appear incrementally is called a text animation slide.
The easiest way to apply animation effects to a slide show is to use Animation
Schemes in the Slide Design task pane. Animation Schemes gives you oneclick access to professionally designed animations divided into three
categories: Subtle, Moderate, and Exciting. Most of these have sound
connected to them. To preview each animation scheme, you can cycle through
the various options until you find the animation you want.
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You can apply animation effects in Slide Sorter view or in Normal view. If you
apply an animation effect in Slide Sorter view, PowerPoint applies the effect to
every object on the slide except the title and background objects. If you apply
an animation effect in Normal view, you need to select the objects on the
current slide that you want to animate and then apply the effect.
If you would rather create your own animation scheme, you can customize the
animation of an object by selecting the Custom Animation command on the
Slide Show menu. Custom animations include moving multiple objects
simultaneously, moving objects along a path, and applying sequencing for all
effects on the slide. You can add animation schemes to each slide, or with one
click, you can apply an animation scheme to all slides in a presentation.
If you apply both a transition effect and an animation effect to a slide, the
transition effect will occur first, followed by the animation effect.
In this exercise, you open Animation Schemes in the Slide Design task pane,
apply an animation scheme to a single slide and multiple slides, and then
customize text animation.
1

In Slide Sorter view, select slide 8.

2

On the Slide Show menu, click Animation Schemes.
The Slide Design task pane opens with a selection of animation
schemes.

3

In the Slide Design task pane, under Apply to selected slides, click
Fade in all.
PowerPoint applies the animation effect to the slide. An animation
symbol appears below the left corner of slide 8.

4

Click slide 2, hold down Shift, and then click slides 3 and 4.
Slides 2, 3, and 4 are selected.
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5

In the Slide Design task pane, under Apply to selected slides, click
Faded wipe.
PowerPoint applies the animation effect to all three slides. An
animation symbol appears below the left corner of each slide.

6

In Slide Sorter view, double-click slide 1 to switch to Normal view
and to display slide 1.

7

On the Slide Show menu, click Custom Animation.
The Custom Animation task pane opens with the text prompt Select
an element of the slide, then click “Add Effect” to add animation.

8

Click the title text Give Your Image Impact, and then click Add
Effect in the Custom Animation task pane.
The Add Effect submenu appears with four effect categories:
Entrance, Emphasis, Exit, and Motion Paths.

9

Point to Entrance, and then click Fly In.
The animation effect is demonstrated on slide 1. In the Custom
Animation task pane, the title text (item 1), and a description of the
effect appear in the Animation Order list.

10

Click the subtitle text Contoso Ltd.

11

In the Custom Animation task pane, click Add Effect, point to
Emphasis, and then click Spin.
The animation effect is demonstrated. In the Custom Animation
task pane, the subtitle text (item 2), and a description of the effect
appear in the Animation Order list.

12

Click the Slide Show button.
Slide 1 appears without the title.
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13

Click anywhere on the screen to display the Fly In effect, and then
click the screen a second time.
The company name spins.

14

Click the screen to display slide 2.
The title fades into view but the bullets don’t display until you click
the mouse.

15

Click the screen as many times as necessary to display all of the
bulleted items on slide 2, the title and object on slide 3, and the title,
picture, and two bulleted items on slide 4.

16

Press Esc.

Animating Slide Objects
In addition to animating text in a slide show, you can customize the animation
of slide objects, such as drawn objects. As with text, to set custom animation
effects, you must be in Normal view.
If you have an object with text, you can animate the text and the object
separately or together. The default is for the object and its text to be animated at
the same time. If you want, you can animate only the text in an object.
Another way to customize object animation on a slide is to change the order of
appearance for text or shapes on the screen during a slide show.
In this exercise, you animate slide objects and change the order in which
objects animate.
1

In Normal view, drag the scroll box to slide 6.

2

Drag the mouse to draw a selection marquee around the three
shapes and the connectors.

3

In the Custom Animation task pane, click Add Effect, point to
Entrance, click More Effects, and then click Peek In.
The three objects and two connector lines are animated. The
number 1 appears next to each of the five parts to show that they
are all animated at the same time.

4

At the bottom of the Custom Animation task pane, click Slide Show,
and then click the screen.
The three objects and connector lines appear all at once.

5

Press Esc to end the slide show.

6

In the Animation Order list, click Elbow connector 6, click the ReOrder up arrow at the bottom of the task pane two times, click the
Start down arrow, and then click After Previous.
The Elbow connector 6 animation order changes from fourth to
second.
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7

In the Animation Order list, click Elbow connector 7, click the ReOrder up arrow once, click the Start down arrow, and then click
After Previous.
The Elbow connector 7 animation order changes from fifth to fourth.

8

In the Animation Order list, click Bevel 4: Recognition, click the
Start down arrow, and then click After Previous.

9

In the Animation Order list, click Bevel 5: Relax, click the Start
down arrow, and then click After Previous.

10

At the bottom of the Custom Animation task pane, click the Slide
Show button, and then click the screen to view the entire slide
content.
The objects and connector lines appear one after another from top
to bottom.

11

Press Esc to end the slide show.

Hiding a Slide During a Slide Show
You might want to customize a presentation for a specific audience, in which
case all of the slides in the current slide show may not be necessary. By using
the Hide Slide command, you can hide the slides you don’t want to use during a
slide show but still want to keep.
In this exercise, you hide a slide in the current slide show.
1

Click the Slide Sorter View button.

2

Select slide 10.
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3

On the Slide Sorter toolbar, click the Hide Slide button.
A hide symbol appears over the slide number to indicate that the
slide will be hidden in a slide show, as shown in the following
illustration:

4

Select slide 9.

5

Click the Slide Show button, and then click anywhere on the
screen.

6

The slide show hides slide 10 and displays slide 11.

7

Press P to go back to slide 9.

8

Right-click anywhere on the screen, point to Go, point to By Title,
and then click (10) Planning for the Future; or press the H key to
show the hidden slide.
The hidden slide appears in Slide Show view.

9

Press Esc to end the slide show.

Lesson Wrap-Up
This lesson covered how to draw on a slide during a slide show, add slide
transitions, animate text, animate objects, and hide a slide during a slide show.
If you are continuing to the next lesson, save and close the presentation:
1

On the Standard toolbar, click the Save button.
PowerPoint saves any changes to the presentation.

2

On the File menu, click Close.
PowerPoint closes the presentation.
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If you are not continuing to other lessons, save and exit PowerPoint:
1

On the Standard toolbar, click the Save button.
PowerPoint saves any changes to the presentation.

2

Click the Close button in the top-right corner of the PowerPoint
window.
PowerPoint closes the presentation, and then exits.

Quick Quiz
1

How do you view the Custom Animation settings?

2

How do you eliminate a transition effect from all of the slides in a
presentation?

3

How do you move forward in Slide Show view?

4

How do you immediately end a presentation in Slide Show view?

5

How do you change the color of the annotation pen?

6

How do you hide a slide during a slide show?

Putting It All Together
Exercise 1: Open Contoso Company Pres 07 in the Lesson07 folder that is
located in the Presentation Fundamentals Practice folder. Change the slide 1
transition to Box In with a slow speed, hide slide 13, start a slide show, change
the pen color to red, draw a line under the text Contoso, Ltd on slide 1, display
each slide in the slide show, and then save and close the presentation.
Exercise 2: Open Contoso Company Pres 07 in the Lesson07 folder that is
located in the Presentation Fundamentals Practice folder. Animate the clip art
on slide 4 with the Fly In effect from the bottom, create and show a custom
slide show named Contoso Client with the slides 1, 4, 6, 7, 8, 9, and 14, and
then save and close the presentation.

